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The Purpose of the SEO Engine 
The SEO Engine is the World’s First Transparent Search Engine.  While you will find that the SEO Engine 
presents an opportunity to be a world-class CRM-solution, reporting engine, rules engine, and lead 
generation tool, among other things – its primary purpose is to increase your overall efficiency in 
implementing SEO.  Many users tend to miss this very important point.  While the SEO Engine allows 
you to quickly uncover penalties, errors, and warnings about everything in a Website, its true value is 
the transparency and immediacy in which you can fix these errors. 

The SEO Engine is setup for both novice and experienced users.  At every possible point, there exist 
hovers and question marks   that give a brief explanation, as well as a link to the material needed to 
understand in more detail.   

Your goal should be to master the primary screens in the SEO Engine and how to navigate between 
them to quickly and efficiently find and correct problems uncovered by the SEO Engine: 

Note: You now must be PRO Enabled and have Site Monitoring for your Website, to access 
most of the screens inside the SEO Engine Interface. 

1. Search Listing – Every Website on the Internet has one.  This view is accessed by entering a URL 
into the Search Bar at the top of any of the above screens.  This view resembles the 
conventional Search Engine Results Pages (SERPs), which allow you to quickly search for a 
particular set of keywords.  The results listings have links into the corresponding Webpage 
Scoresheets and Scorecards of each Webpage displayed. 

2. Webpage Scoresheet – Every Webpage on the Internet has one.  Shows on-page penalties, 
errors, and warnings, as well as various critical pieces of data like Market Focus(TM), Link 
Loss(TM), and much more.   

3. Webpage Snapshot – Every Webpage on the Internet has one.  Similar to Google’s “cached” 
view, the Webpage Snapshot also allows the SEO Engine to overlay various information found 
throughout the SEO Engine interface.  For example, when viewing Dangling Links on the Link 
Listing page, you can also get a Snapshot View of these Links by clicking the Snapshot View icon. 

4. Webpage Scorecard – Every Webpage on the Internet has one.  Shows on-page and off-page 
penalties, errors, and warnings, and details out the exact formulas that were used to determine 
that Webpage’s SEO Engine Score(TM). 

5. Market Focus Details – Every Webpage on the Internet has one.  Shows how the Search Engine 
views the content on that Webpage.  It is a complete breakdown off contributing factors that 
caused the Search Engine to determine what that Webpage is about. 

6. Link Listings – These exist on both the Webpage and Website level.  Link listings are like Search 
Results, but each result is a Link, with all information regarding that Link summarized in a 
dropdown list. 

7. Link Scorecards – Every Link on the Internet has one.  Shows a detailed breakdown of how the 
Search Engine determined the Link Flow(TM) for that particular Link, in context with all of the 
other Links on and around that Webpage. 
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8. Page Listings – These exist on both the Webpage and Website level.  Page listings are like Search 
Results, but they show specific categories of information. 

9. Website Dashboard – Each sub-domain on the Internet has one.  This is the “top level” of the 
screens presented here for a given Website.  All aggregate information regarding a Website is 
presented here. 

How to get Training and Support 
If you added a PRO Support Tier, you will automatically receive a certain amount (depending on the Tier 
you selected) of Training and Support.  If you do not have a PRO Support Tier, or just need additional 
Training and/or Support, you can click on Schedule / View Training & Help from your Customer Home.   

A Training Incident = 1 hour of Training and/or Consulting.   

If you have the necessary Incidents available, contact your SEO Engine Certified Professional to open an 
Incident.  They will manage your Incident, which can be seen by viewing your Incidents.  You can view 
your Incidents by clicking the Schedule / View Training & Help button on your Customer Home.   

 

Simply click on the Title to view your Incident Details, which includes all notes provided by your Certified 
Professional. 

How to Purchase a Site Monitor(TM) for a Website 
After logging in, enter your Website into the Add Site Monitor form on the top right of the Customer 
Home Screen. 
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You will be taken to the Instant Quote screen.  There you can review the price, adjust the details, and 
then click Next. 

 

Add optional PRO Features… 

 

Confirm and provide your payment information and you are done. 
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The Difference between Crawled Webpages and Scored Webpages 
For PRO Members, The SEO Engine allows you to adjust the # of scored Webpages on the Instant Quote.   

 

This is the number of Webpages that the SEO Engine will attempt to score.  Scoring a Webpage entails: 

1. Crawling the Webpage 
2. Crawling every Link on the Webpage 
3. Calculating all metrics for Webpage 

• Off-Page 
• On-Page 

4. Calculating all metrics for every Link on Webpage 
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The order in which Webpages will be found is determined by Crawl Depth first and then Starting 
Position on the Webpage.  In addition to crawling all Webpages that are linked from the scored 
Webpages, the SEO Engine also will attempt to crawl Orphaned Webpages (up to 10% of the amount of 
scored Webpages).  Below are some examples of typical Customer issues that may come up. 

Example 1 – The SEO Engine didn’t crawl all of my Webpages 
If a Website has 100 Webpages, and 25 Webpages are scored, the SEO Engine may not end up crawling 
all 100 Webpages – unless all 100 Webpages are linked from the 25 Webpages that are scored.   

Example 2 – I fixed my Broken Links, but it didn’t show up on the SEO Engine  
This is a variation of the first example.  If the Broken Links were on a Webpage that didn’t get crawled, 
the SEO Engine will continue to show the data from the last crawl.  There are a few ways to check 
staleness in the SEO Engine.   

The first is to check the Last Crawled date on the Crawl Statistics for a Webpage (shown below), located 
on its Webpage Scoresheet. 

 

The second is to check the Link Statistics for a given Link.  This can be found by clicking on the Toggle 
Link Details button on any Link Listing. 
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How to Add PRO Features 
If you are not a PRO Member, navigate to the Customer Home and click on the enable button. 

 

You will be presented with PRO Features to choose from. 
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Choose the features you want to add and click the Add Pro Features button.  

 

Confirm and provide your payment information and you are done. 

How to View/Edit your Customer Information 
Navigate to the Customer Home and click on the Edit Settings button. 
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You will be presented with the SEO Engine Settings Screen. 

 

From here, you can edit the various settings used in your account. 

View Customer Transactions 
From your Customer Home, click on the View Info tab and then the View Transaction History link. 
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From here, you can select and view the various transactions that have occurred.   

How to View and Manage your Child Customer Information  
If you have a Child Customer, you will be able to view and manage your Child Customer Account directly 
from your Customer Home.  Simply click on the View Child Customers link to view a listing of all of your 
Child Customer Accounts.  Click on a Customer to drill-down into their Customer Info, where you can 
enable/disable the Customer Account by selecting the Disable/Enable This Customer button.  You can 
also view their Transaction History by clicking on the View Transaction History button. 

How to Cancel/Edit a PRO Feature 
As a PRO Member, navigate to the Customer Home and click on the edit button on the top left.   
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Choose which PRO Feature you would like to cancel, and then click the Cancel Selected Features button.  
If you want to add a feature, click on the Add More Features button. 

 

Any features that you have already scheduled to be canceled will be shown as such.  Note: You must re-
add those features before the cancellation date, or that feature will stop working.  

Schedule On-Demand  Crawls of a Website 
If you are a PRO Member, and already have Site Monitoring enabled for a Website, the SEO Engine 
provides the ability to schedule on-demand  crawls of a Website at any time, with any recurring 
frequency.  Simply navigate to the view more link under the SEOPass list on the Customer Home. 

 

Then choose which Website you want to setup a scheduled crawl, and click on the more actions link to 
select the Manage Scheduled Crawls action link. 
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Then, fill out when you want the next re-crawl date to be, along with the recurrence time and number of 
recurrences.  Once you have saved this schedule, your Website will automatically be re-crawled at the 
appropriate times, and the applicable fees will be charged using your existing payment method.  Visit 
this page to cancel your schedule if you no longer want this schedule to remain in effect.  If you want 
this schedule to occur only once, simply fill in 0 for the recurrence time and number of recurrences. 

 



15 
 

Copyright (C) 2001-2011 SEOEngine.com. All Rights Reserved. Patent Pending. 
Reproduction and/or distribution is strictly prohibited without the written consent of SEOEngine.com. 

 

How to share your SEOPass 
If you are a PRO Member, you have the option of sharing any SEOPass with another Customer.  Simply 
navigate to the view more link under the SEOPass list on the Customer Home. 

 

Then choose which Website you want to setup a scheduled crawl, and click on the more actions link to 
select the Share SEOPass action link. 

 

Type in the Customer’s Email and click the Share SEOPass button.  The Customer will receive an 
automatic email confirming their new SEOPass access.  You will also receive a confirmation as well.  This 
Customer will now have full access to this Website’s data in the SEO Engine. 
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How to Create SEO Engine Rules(TM) 
If you are a PRO Member, the SEO Engine provides the ability to personalize your own Search Engine 
and sort through all of the information to receive only the information and alerts that you want.   

SEO Engine Rules(TM) are customized alerts that you can define as a SEO Engine Customer. Each rule is 
specific to a particular Customer and a Website. Whenever a Website is re-crawled, each rule that was 
defined for that Website is evaluated. If the rule condition is TRUE, then the Customer is alerted 
instantly. 

The SEO Engine makes it very easy to create simple rules. When logged in, simply click on any  icon 
next to the item you wish to create a rule with.  

 

Then, you simply follow the SEO Engine Rules(TM) Wizard. Select your condition, (optionally) enter a 
value, name the rule, and you're done!  SEO Engine Rules(TM) are fired off only after a Website has 
been re-crawled.  



17 
 

Copyright (C) 2001-2011 SEOEngine.com. All Rights Reserved. Patent Pending. 
Reproduction and/or distribution is strictly prohibited without the written consent of SEOEngine.com. 

 

 

SEO Engine Rule Operators 

The following standard operators can be used in a SEO Engine Rule. Note, all Text should be enclosed 
with double quotes ("").  

  Operator Numeric Text 
Power ^ 

 

  
Boolean Not ! 

 

  
Boolean And && 

 

  
Boolean Or || 

 

  
Less or Equal, More or Equal <=, >= 

 

  
Less Than, Greater Than <, > 

 

  
Not Equal, Equal !=, == 

  

Assignment = 
  

Unary Plus, Unary Minus +x, -x 
 

  
Dot product, cross product ., ^^     
Modulus % 

 

  
Division / 

 

  
Multiplication * 

 

  
Addition, Subtraction +, - 

  (only +) 

Adding Custom SEO Engine Rules 
You don't have to just use the SEO Engine Rules Wizard. You can define your own customized 
equations/conditions to your own liking.  

 



18 
 

Copyright (C) 2001-2011 SEOEngine.com. All Rights Reserved. Patent Pending. 
Reproduction and/or distribution is strictly prohibited without the written consent of SEOEngine.com. 

 

On the Edit Rules screen, you can select any available piece of information in the SEO Engine to create 
simplest or the most complex rule you can imagine. 

 

Below are some simple examples of what you can do with SEO Engine Rules(TM). Using any of the 
operators above, you can combine any piece of data for a Website, and come up with a new and 
customized alert system. The combinations are endless — only your imagination holds you back.  

• Check to see whether or not a Website has any Broken Links:  

numBrokenLinks > 0  

• Check to see whether or not a specific Webpage has issues loading on the Web Server. You may 
be having issues with your Hosting Provider and want to know if the Webpage load times are 
sufficient enough for your user experience / SLA:  

retrieveTimeMillis > 5000  

• Check to see whether or not a Webpage's SEO Engine Score(TM) has fallen below 85.5%. Let's 
assume that a particular Webpage has been optimized and now has a SEO Engine Score(TM) of 
85.5%. You want to know if something changes which cause the Webpage to have more 
penalties and a lower score:  

seoengScore < 85.5  

• Check to see whether or not a Webpage's Market Focus(TM) is no longer "search engine 
optimization". This would let you know when an edit on a Webpage accidently changes your 
Market Focus(TM), thus causing your target keywords to drop in ranking:  

marketFocus != "search engine optimization"  
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• Check to see whether or not a Link's net Link Flow(TM) Share drops below a threshold. You 
might want to know when a Link that you have on another Website is of no longer use:  

(netLinkFlowPercent/100) * linkFlow < 25.75  

Manage SEO Engine Rules(TM) 
Simply navigate to the view more link under the SEOPass list on the Customer Home. 

 

Then choose which Website you want to setup a scheduled crawl, and click on the more actions link to 
select the Manage SEO Engine Rules action link. 

 

The list displays your SEO Engine Rules(TM) for each Webpage and also shows rules created for the 
Website as a whole. 
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You may drill-down into each Webpage’s rules, or manage your Scheduled Crawls directly from this 
view. 

 

Click on any SEO Engine Rule(TM) to enter the Edit Rule screen.  In this screen, you may modify your 
rule, delete your rule, or test different changes to the rule to see if it would fire or not. 
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The Private Label 
One of the more lucrative PRO Features that the SEO Engine offers is the ability to have their very own 
branded version of the SEO Engine Interface. 

Our Sticky Ad(TM) Technology makes sure that when a customer visits the SEO Engine through your 
customized SEO Engine Search Bar, they will always see your advertisements exclusively.  Even if the 
customer leaves and comes back in a week, and even if they then go directly to www.seoengine.com 
and type their Website in, your advertisements and branding will be shown.  This proprietary 
technology allows Customers (with Private Labeling Enabled) the ability to control what visitors see on 
the SEO Engine, thus producing an automated stream of revenue and leads from customers that want to 
fix their Website and and/or use your services. 

The customized the SEO Engine can be configured in the Customer Home as shown below, by clicking on 
View/Edit Private Label. 

 

http://www.seoengine.com/
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You will be presented with the menu to manage your Sticky Ads(TM) and develop your own customized 
SEO Engine. 

 

The following steps show how easy it is to get your own customized the SEO Engine up and running: 

1. Upload your Ad Images. 
2. Preview your Staged Ads before you publish them LIVE. 
3. Enabled your Staged Ads to become LIVE Ads. 
4. Download your customized the SEO Engine Search Bar, and place it on your Website. 

Upload your Ad Images 
The first step is to upload your Ads.  In the Custom Ads Overview table, you will see the Ads which are 
available currently in the system.  Click on the Upload New Staged Image next to the Ad Type you wish 
to display. 
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You will be presented with the Ad Image size, type, and dimension requirements.  Click the Browse 
button to upload from your local computer.  Fill in a URL that you wish this Image to be linked to, and 
click Upload Ad Image.  Once completed, your Ad Image will be displayed in the Custom Ads Overview 
table, and confirmation of success will be displayed. 

Preview your Staged Ads before you publish them LIVE 
Once you have uploaded your Ad Images, you will want to preview what the system will look like to 
potential customers when they arrive at the SEO Engine through your Website’s customized the SEO 
Engine Search Bar.   

 

Enabled your Staged Ads to become LIVE Ads 
Click the GO LIVE! button once you are happy with the Sticky Ads(TM).  This will transfer your Staged Ads 
to the LIVE system and will then be shown to your customers coming to the SEO Engine.  Note:  It may 
take up to 5 minutes for the changes to propagate to all of the SEO Engine servers. 

Download your customized SEO Engine Search Bar, and place it on your 
Website 
Visit the link titled Download Custom SEO Engine Search Bar to download. 
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Please note that these Search Bars are specifically designed to cause the visitors to see your own Sticky 
Ads(TM).  And that’s it!  Select the SEO Engine Search Bar of your choice, and place it on your Website.  
Visitors will type their Website into this Search Bar and be taken to the SEO Engine where they will see 
your Sticky Ads(TM) which tell them to contact you if they need help fixing their Website. 

Callbacks 
The SEO Engine allows you to set a “Default Callback URL” in your Customer Home  Edit SEO Engine 
Settings Screen.  You may specify a valid URL for the SEO Engine to issue a HTTP GET request, after a 
Website has been analyzed.  This URL will be called, with a parameter “website” appended to it.  Note:  
The SEO Engine will NOT attempt to retry failed attempts to connect to the Callback URL. 

Example: 

You set your Default Callback URL to:  http://www.mywebsite.com/seoengine-callback.php.  One of 
your Custom Search Bar users enters a Website www.foo.com, into your Custom SEO Engine Search Bar.  
After the Website has been successfully analyzed, the following URL is requested:  
http://www.mywebsite.com/seoeng-callback.php?website=http://www.foo.com, notifying you that this 
Website has been analyzed. 

SERPvision(TM) – the SEO Engine Reporting Engine 
SERPvision is a powerful SEO reporting engine that sits on top of the Search Engine.  Simply navigate to 
the view more link under the SEOPass list on the Customer Home. 
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Then choose which Website you want to setup a scheduled crawl, and click on the more actions link to 
select the Manage SEO Engine Rules action link. 

 

SERPvision allows you to immediately export data for a given Website, Webpage, or Link directly to a 
PDF file, based off of a predetermined reporting template.  You will have standard reporting templates 
previously created by the SEO Engine as a default.  If you wish, you may contact the SEO Engine and 
request your own customized templates.  These templates can be any size, shape, font, color, image, 
number of pages, number of data points, etc… The possibilities are endless. 
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Using SERPvision with the Private Label 
If you have both the Private Label and SERPvision PRO Features enabled, you can optionally show any 
SERPvision report to your Private Label visitors on the various screens and also their Crawl Notice Email.  
The default versions are set in the Customer Home  Edit Settings  Edit SEO Engine Settings Screen 
 SERPvision SETTINGS Section. 

 

Simply select the Default SERPvision(TM) templates that you wish to present to your visitors. 

Example #1: 
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Your Private Label visitor enters their Website into your Custom SEO Engine Search Bar.  They are then 
told that their analysis will be complete shortly.  Soon after, they receive an email from the SEO 
Engine with your contact information as well as your Marketing PDF with their personalized report 
attached to the Crawl Notice email.   

Example #2: 

Your Private Label visitor goes to the SEO Engine Interface, and clicks on the Export Data to PDF link. 

 

They are shown the SERPvision report that you selected. 

How to Use the SEO Engine API Web Services 
The SEO Engine API, or “Application Programming Interface”, allows customers to develop their own 
customized interface around the SEO Engine data.  This API / Web Service is accessed through HTTP and 
returns formatted XML according to the SEO Engine API XML Schema Definition.   

SEO Engine API XML Schema Definition 
The public SEO Engine API XML Schema Definition can always be accessed at the following location: 

http://search.seoengine.com/api/schema.xsd 

http://search.seoengine.com/api/schema.xsd
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The XML schema definition file (.xsd) contains all of the information you need to parse responses 
received from the SEO Engine API system.  A small piece of the .xsd file is shown below.  You can use any 
language to consume and process these XML requests and responses.  There are many SDKs that enable 
you to easily and quickly work with this type of markup. 

 

Security/Authentication 
To access the API, you must first assign at least one IP Address to your account.  This is done on your 
Customer Home  Edit Settings  SEO Engine Settings Screen.  Any API Requests from these IP 
Addresses will then be associated with your account. 

 

SEO Engine API Requests 

Request URLs 
The table below illustrates the requests and the URL at which each request can be retrieved.  Note that 
the color shading indicates which requests require an SEOPass before issuing the request (Note: For 
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PRO Members, an SEOPass is automatically added when you add Site Monitoring for a Website).  See 
Pricing Details for the most current pricing information. 

API CALL URL 
WEBPAGE http://search.seoengine.com/api/webpage.xml 
CRAWL http://search.seoengine.com/api/crawl.xml 
CUSTOMER http://search.seoengine.com/api/customer.xml 
QUEUE http://search.seoengine.com/api/queue.xml 
QUOTE http://search.seoengine.com/api/quote.xml 
SITE MONITOR http://search.seoengine.com/api/site-monitor.xml 
MARKET FOCUS DATA http://search.seoengine.com/api/market-focus.xml 
DUPLICATE CONTENT http://search.seoengine.com/api/correlation.xml 
WEBSITE DATA http://search.seoengine.com/api/website.xml 
PRIVACY DATA http://search.seoengine.com/api/privacy.xml 
INDIVIDUAL LINK DATA http://search.seoengine.com/api/link.xml 
ALERTS http://search.seoengine.com/api/alerts.xml 

LINK LISTING http://search.seoengine.com/api/link-listing.xml 
PAGE LISTING http://search.seoengine.com/api/page-listing.xml 
SEARCH LISTING http://search.seoengine.com/api/search-listing.xml 
ON-DEMAND CRAWL http://search.seoengine.com/api/recrawl.xml 
 

NO SEOPASS NEEDED 
SEOPASS NEEDED 

 

Request Details 
The table below illustrates the requests, their parameters, and their corresponding response types.  
Refer to the XML Schema Definitions for the response type definitions.  Note: required parameters are 
in bold.  Note: Responses may include redirects to the final XML response.  Make sure your client 
follows redirects. 

API CALL PARAMETERS (caSe senSitiVe) RESPONSE TYPE 

WEBPAGE DATA &host=<URL Host> 
&path=<URL Path> Webpage 

http://www.seoengine.com/api-web-services.htm
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CRAWL 
&host=<URL Host> 

&email=<email> 
&callback=<Callback URL> 

QueueStatus 

CUSTOMER <none> Customer 

QUEUE &host=<URL Host> 
&email=<email> QueueStatus 

QUOTE &host=<URL Host> Quote 

SITE MONITOR 

&host=<URL Host> 
&numPages=<# of scored pages> 

&javascript=<0|1> 
&resetPages=<0|1> 
&days=<7|14|28> 

&discount=<discount code> 
&callback=<Callback URL> 

PurchaseResult 

MARKET FOCUS 
DATA 

&host=<URL Host> 
&path=<URL Path> MarketFocusResult 

DUPLICATE 
CONTENT 

&host=<URL Host> 
&path=<URL Path> Correlations 

WEBSITE DATA &host=<URL Host> Website 

PRIVACY DATA &host=<URL Host> 
&path=<URL Path> PrivacyInfo 

INDIVIDUAL LINK 
DATA 

&host=<URL Host> 
&path=<URL Path> 

&webpageFrom=<URL> 
&webpageTo=<URL> 

&startPosition=<numeric> 

Link 

ALERTS &host=<URL Host> 
&path=<URL Path> Alerts 

LINK LISTING 

&host=<URL Host> 
&path=<URL Path> 

&type=<see Link Listing Types, default “ao”> 
&start=<numeric, default 1> 

&num=<numeric, default 10, max 100> 
&filter=<filter> 

&filterType=<see Link Listing Filter Types> 
&wholeWord=<0|1> 
&exactMatch=<0|1> 

LinkListing 

PAGE LISTING 

&host=<URL Host> 
&path=<URL Path> 

&type=<see Page Listing Types, default “alp”> 
&start=<numeric, default 1> 

&num=<numeric, default 10, max 100> 
&filter=<filter> 

&filterType=<see Page Listing Filter Types> 

PageListing 

SEARCH LISTING &host=<URL Host> PageListing 
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&query=<query> 

ON-DEMAND 
CRAWL 

&host=<URL Host> 
&numPages=<# of scored pages> 

&javascript=<0|1> 
&resetPages=<0|1> 

&discount=<discount code> 
&callback=<Callback URL> 

PurchaseResult 

 

NO SEOPASS NEEDED 
SEOPASS NEEDED 

 

URL Encoding 
Some of the requests include parameters that require URLs (host, webpageFrom, webpageTo, callback).  
Please ensure that these values are properly encoded.  For more information, please visit: 
http://www.blooberry.com/indexdot/html/topics/urlencoding.htm. 

Additional Callback URL 
Some of the requests initiate processes that do not finish immediately, such as a Crawl, Site Monitor, or 
On-Demand Crawl, and therefore include a “callback” parameter.  This parameter allows you to include 
a callback URL, in addition to your Default Callback URL in your Customer Home.  If you do not specify a 
callback parameter, your Default Callback URL defined in your Customer Home will be used, if set.  Note:  
The SEO Engine will NOT attempt to retry calling this URL in the event of a failure. 

Listing Types 
The following types are used on listing screens. 

Link Listing Types 
The following table illustrates the different types of Link Listings, and their corresponding codes.  They 
consist of “Base Types”, which are then optionally concatenated one or more “Modifier s”. 

Base Types – These are always listed first. 

Type Code (caSe senSitiVe) 
All Outgoing ao 

External Outgoing eo 
Internal Outgoing io 

All Incoming ai 
External Incoming ei 
Internal Incoming ii 

Session ID id 

http://www.blooberry.com/indexdot/html/topics/urlencoding.htm
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Non-Session ID nid 
Cloaked cl 

Non-Cloaked ncl 
Broken bk 

Non-Broken nbk 
Dangling dg 

Non-Dangling ndg 
Followed fol 

Nofollowed nf 
Reciprocal rc 

Non-Reciprocal nrc 
Reciprocal Site-Wide swrc 

Non-Reciprocal Site-Wide swnrc 
Editorial ed 

Non-Editoral ned 
 

Modifiers – These are always concatenated together after the Base Types. 

Type Code (caSe senSitiVe) 
With Session ID wid 

Without Session ID woid 
With Cloaked wcl 

Without Cloaked wocl 
With Broken wbk 

Without Broken wobk 
With Dangling wdg 

Without Dangling wodg 
With Nofollow wnf 

Without Nofollow wonf 
With Reciprocal wrc 

Without Reciprocal worc 
With Reciprocal Site-Wide wswrc 

Without Reciprocal Site-Wide woswnrc 
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With Editorial wed 
Without Editoral woed 

 

Example 1:  Concatenate “ao” (All Outgoing) with “wnf” (With No-Follow), to get All Outgoing Links with 
a “nofollow” attribute.  [&type=aownf] 

Example 2:  Concatenate “dg” (Dangling ) with “wnf” (With No-Follow) and “woed” (Without Editorial) 
to get All Dangling Links with a “nofollow” attribute that are not Editorial.  [&type=dgwnfwoed] 

Page Listing Types 
The following table illustrates the different types of Page Listings, and their corresponding codes.  They 
consist of “Base Types” only. 

Base Types 

Type Code (caSe senSitiVe) 
All Documents ald 

All HTML Webpages alp 
Missing META Title mmt 

Missing META Description mmd 
Duplicate META Title dmt 

Duplicate META Description dmd 
Duplicate Market Focus dmf 

Duplicate Spelling dus 
Exact Duplicate Content duce 

Irrelevant irr 
Orphaned orp 

Filter Types 
The following types are used on listing screens to filter results even further. 

Link Listing Filter Types 
The following table illustrates the different types of filters that can be used on Link Listings, and their 
corresponding codes. 

Link Listing Filter Types 

Type Code (caSe senSitiVe) 
Webpage From webpageFrom 

Webpage To webpageTo 
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Anchor Text anchortext 

Page Listing Filter Types 
The following table illustrates the different types of filters that can be used on Page Listings, and their 
corresponding codes. 

Page Listing Filter Types 

Type Code (caSe senSitiVe) 
Title title 

Description desc 
Market Focus marketFocus 

URL url 
 

Pricing 
All API Requests are charged on a per-call basis, and monthly usage fees are processed at the end of 
each billing cycle.  You may view a breakdown of your historical API Requests by viewing your API Usage 
under the View Info tab on your Customer Home.   

 

Please visit http://www.seoengine.com/api-web-services.htm for more information on pricing and the 
latest on the SEO Engine API Platform. 

http://www.seoengine.com/api-web-services.htm
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Testing 
You may test the API system by utilizing the keyword “TESTDRIVE” for your <URL host> parameter.  The 
SEO Engine will NOT bill your account, enabling you to develop your application in the live environment 
without worrying about charges. 

Take SEO Engine Tests and Increase your Knowledge of the SEO Engine 
Click on the Manage/Take Tests on the Help tab on your Customer Home. 

 

Then click the Take Test tab and choose your type of Test (Customer or Certified Professional). 

 

The test will be timed, and the results will be visible to your Certified Professional, so that he/she may 
be able to help you with the SEO Engine.  Each test will be unique – questions and answers are selected 
from a larger list and randomly presented, so the test taker cannot memorize the test. 

SEO Engine Learning Center 
You can visit the SEO Engine Learning Center at http://www.seoengine.com/learning-center/ for more 
information regarding how to use the SEO Engine.  

http://www.seoengine.com/learning-center/
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APPENDIX 

API Sample Request/Responses 
The following is a small sample of API calls, intended to give you an idea of the Request/Response 
mechanism.  Note: Developers should refer to the latest XML Schema Definition file for the most up to 
date information. 

Website 
Request:  http://search.seoengine.com/api/website.xml?host=www.trumbullnaturecenter.com 

Response: 

 

  

http://search.seoengine.com/api/website.xml?host=www.trumbullnaturecenter.com
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Webpage 
Request:  http://search.seoengine.com/api/webpage.xml?host=www.trumbullnaturecenter.com&path= 

Response: 

 

  

http://search.seoengine.com/api/webpage.xml?host=www.trumbullnaturecenter.com&path


38 
 

Copyright (C) 2001-2011 SEOEngine.com. All Rights Reserved. Patent Pending. 
Reproduction and/or distribution is strictly prohibited without the written consent of SEOEngine.com. 

 

Market Focus 
Request:  http://search.seoengine.com/api/market-
focus.xml?host=www.trumbullnaturecenter.com&path= 

Response: 

 

  

http://search.seoengine.com/api/market-focus.xml?host=www.trumbullnaturecenter.com&path
http://search.seoengine.com/api/market-focus.xml?host=www.trumbullnaturecenter.com&path
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Correlation 
Request:  http://search.seoengine.com/api/webpage.xml?host=www.trumbullnaturecenter.com&path= 

Response: 

 

http://search.seoengine.com/api/webpage.xml?host=www.trumbullnaturecenter.com&path
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